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SUMMARY

We describe a fluorescence recovery after photobleaching (FRAP) protocol for
assessing the dynamics of heterochromatin/euchromatin and identifying chro-
matin relaxers for cell fate transition. Here, we developed a system to track het-
erochromatin foci with HP1a-cherry and performed FRAP assay of H1-GFP to
analyze the dynamics of heterochromatin and euchromatin during somatic cell
reprogramming. This protocol is used to screen factors that impact chromatin
structure, which could also be used to identify chromatin relaxers and repressors
in various cell fate transitions.
For complete details on the use and execution of this protocol, please refer to
Chen et al. (2016) and Chen et al. (2020).

BEFORE YOU BEGIN

The protocol below describes the specific steps for usingMEF cells. However, we have also used this

protocol in NIH3T3, human fibrosis and other cells.

Plasmid construction

Timing: 1 week

1. The DNA coding full length of mouse H1.4 fusion with EGFP were inserted into pMXs-flag

plasmid (pMXs-H1-GFP). The same for construction of pMXs-HP1a -Cherry, containing the full

length of mouse HP1a fusion with mCherry (Chen et al., 2016). Other plasmids coding these

two genes could also be used. The plasmids coding the genes of interesting could also be con-

structed in the similar way.

Prepare cells

Timing: 2 days
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2. MEF, NIH3T3 or other cell lines could be used. Plate-E cell are used to produce retrovirus. Recov-

ery the cells, such as MEF from liquid nitrogen before the experiment. Culture the cells in normal

condition for at least 2 days priority to start the experiment.

CRITICAL: When primary cells, such as MEF cell were used, too much passage should be

avoided, as the senescence of primary cells will affect the test. We usually use 2–4 passage

of MEF cells.

KEY RESOURCES TABLE

MATERIALS AND EQUIPMENT

A laser confocal microscope with incubator system, including temperature, humidity and CO2 con-

centration control. We used a Zeiss LSM880 laser confocal with an incubator system for the assay.

Alternatives:Most laser confocal microscopes equipped with humidity control system for live

cell imaging could be used, such as Zeiss LSM710, LSM800, LSM880; Leica SP8, SP5; Nikon A1

or Olympus FV1200 and so on.

REGENT OR SOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

PEI PolyScience Cat#23966

Polybrene Sigma Cat#H9265

Gelatin Sigma Cat#ES-006-B

Opti-MEM Gibco Cat#31985-023

DMEM HyClone Cat#SH30022-2B

FBS Gibco Cat#NTC-HK008

NEAA Gibco Cat#11140-050

GlutaMAX Gibco Cat#35050-061

Penicillin/Streptomycin HyClone Cat#SV30010

Confocal dish WPI Cat#FD35-100

Precoated confocal dish WPI Cat#FD35PDL-100

0.45 mm Sterile filter Millipore Cat#SLHVR33RB

Recombinant DNA

pMXs-H1-GFP This study N/A

pMXs-HP1a -Cherry This study N/A

Experimental models: Cell lines

MEF cells This study N/A

Human fibroblast This study N/A

Platinum-E (plat-E) A gift from the FourthMilitaryMedical
University

N/A

Software and algorithms

Zeiss Zen2 Zeiss Zeiss, commercially available

Fiji ImageJ Schneider et al., 2012 https://imagej.net/Fiji/Downloads

Multi measure plugin N/A https://www.optinav.info/Multi-Measure.
htm

StackReg plugin Thevenaz et al., 1998 http://bigwww.epfl.ch/thevenaz/
stackreg/

TurboReg plugin Thevenaz et al., 1998 http://bigwww.epfl.ch/thevenaz/
turboreg/

GraphPad Prism 5.0 GraphPad Software Inc. https://www.graphpad.com/
scientific-software/prism/

Microsoft Excel Microsoft Microsoft

Other

LSM880 confocal microscope with
incubator system.

Zeiss Zeiss, commercially available

ll
OPEN ACCESS

2 STAR Protocols 2, 100706, September 17, 2021

Protocol

https://imagej.net/Fiji/Downloads
https://www.optinav.info/Multi-Measure.htm
https://www.optinav.info/Multi-Measure.htm
http://bigwww.epfl.ch/thevenaz/stackreg/
http://bigwww.epfl.ch/thevenaz/stackreg/
http://bigwww.epfl.ch/thevenaz/turboreg/
http://bigwww.epfl.ch/thevenaz/turboreg/
https://www.graphpad.com/scientific-software/prism/
https://www.graphpad.com/scientific-software/prism/


GraphPad Prism 5.0, 8.0 or other versions could be used in FRAP curve construction. Microsoft Excel

could also do all the calculation and FRAP curve construction.

All kinds of transfection reagents could be applied according to the manual, not restricted to PEI.

All kinds of mammalian cells could be used; we use MEFs as a model cell line.

STEP-BY-STEP METHOD DETAILS

Cell labeling

Timing: 4–5 days

The dynamics of chromatin could be detected as the dynamics of linker histone H1. The cells should

be labeled with H1-GFP, which will be tested by FRAP. Another marker for heterochromatin HP1a--

cherry is used to indicate heterochromatin foci. Then, test genes could be overexpressed or knock-

down in the test cell to detect the effect on chromatin dynamics in specific process, such as somatic

cell reprogramming and so on (Chen et al., 2016., Chen et al., 2020). It could also be used to test the

effect of drugs on chromatin dynamics and so on.

1. Collect virus coding H1-GFP and HP1a-cherry.

a. Seed Plate-E cell in a 10 cm dish at proper density about 50% confluence the day before trans-

fection.

b. Transfect the cell with 10 mg plasmid encoding H1-GFP or HP1a-cherry, mixing with 40 mL PEI

(1 mg/mL) per dish.

c. Collect the culture medium containing virus 48 h after transfection and remove cell fragments

with a 0.45 mm sterile filter.

d. Repeat the virus collection once 24 h later after replacing fresh medium. It can be stored in 4�C
for about 1 week. For long time storage, it could be kept in �80�C within 1 year.

2. Labeling cells.

a. Seed the model cells (MEF cells in this protocol) on a 6 cm cell culture dish.

b. Add polybrene (6 ng/mL in final concentration) to the virus medium to improve the infection

efficiency.

c. Label the MEF cell by adding the 5 mL virus medium containing retrovirus coding H1-GFP and

HP1a-Cherry. The amount of H1-GFP should be more than HP1a-cherry, such as 4 mL H1-GFP

and 1 mL HP1a-cherry virus medium.

d. Repeat the infection step with 4 mL fresh virus medium containing only H1-GFP 24 h after the

first infection to improve the expression level of H1-GFP (troubleshooting 1).

e. Replace with fresh culture medium 12 h after the secondary infection.

f. Check the transfection efficiency with fluorescence microscope 48–60 h after first infection.

3. Test genes overexpression or knockdown.

a. Seed the MEF cells in a 6-well dish after labeled with H1-GFP and HP1a-cherry.

b. Infects the model cells with virus encoding test gene 12 h after seeding the model cells.

c. Repeat the infection step once more to improve the efficiency 24 h after the first infection.

MEF cell culture medium

Regent Final concentration Volume (ml)

DMEM 87% 435

FBS 10% 50

NEAA 1% 5

GlutaMAX 1% 5

Penicillin/Streptomycin 1% 5

Stored in 4�C within 1 month.
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CRITICAL: The virus amount of H1-GFP and HP1a-cherry could be adjusted to ensure the

brightness of H1-GFP, but keep a minimal signal of HP1a-cherry. The labeling efficiency

should be checked under a fluorescence microscope to make sure most of the cells are

labeled with both H1-GFP and HP1a-cherry.

Pause point: We carried out the FRAP imaging as soon as MEF cells labeled, which should

only be used within about 5 passages after labeling with H1-GFP and HP1a-cherry as it would

become senescence after several passages. The human fibroblast or other cell lines could be

stored in liquid nitrogen and used for a long time after labeling with H1-GFP and HP1a-cherry

in step 2.

FRAP imaging

Timing: 2–3 h

The dynamics of chromatin is detected by the recovery rate linker histone H1 after photobleaching

(FRAP). The chromatin could be distinguished by heterochromatin marker with HP1a and euchro-

matin without HP1a-cherry fluorescence. The dynamics of these two groups of chromatins could

be recorded separately.

4. Seed the cells on a new confocal dish with glass bottom precoated with 0.1% gelatin or seed on a

confocal dish precoated with Poly-D-Lysine (FD35PDL-100, WPI) for cells attaching not well on

glass after labeling with H1-GFP and HP1a-Cherry (Figures 1A–1C). Culture the cell in the normal

condition at 37�C with 5% CO2 for 24–48 h before imaging.

5. Put the dish on the stage of the confocal microscope and prewarmed for 5–10 min (Figure 1D).

High magnification lens, such as 633 or 1003 oil objective (N.A.R1.4) lens should be used.

6. Find the focus and adjust the setting of the confocal microscope (Figure 1E). To improve the

acquiring rate, the frame size could be set as no more than 5123512 pixels. Make sure the acqui-

sition time should be less than 1 s for each frame with a single-channel acquisition model.

Here is the detail of setup for imaging using Zeiss LSM880 as example (Methods video S1).

a. Open the software of Zen 3 black edition

b. Click acquisition bottom.

c. Choose ‘‘Time series’’, ‘‘Bleaching’’ and ‘‘Regions’’.

d. Set the argon laser (or 488 nm laser) and 561 nm laser on.

e. Setup two trackers for imaging, one for EGFP and another for mCherry with proper filter, such

as MBS 488/561.

f. Setup the laser power and gain value. The 488 nm laser power for EGFP should be as lower as

possible, such as 0.2% for laser power, while 680 for gain value (using a GaAsP PMT).

g. Adjust the imaging scale and set the zoom factor as 3 for 633 objective lens or 2 for 1003

objective lens. h. Adjust the focus.

7. Acquiring a two-channel image including H1-GFP and HP1a-cherry at first (Figure 2). This image

could be used to select interesting regions for bleaching. Select about 2 to 3 regions with 20

pixels in diameter (less than 2 mm) for bleaching. Select 1 region of heterochromatin foci marked

with HP1a or 1-2 non-foci regions (Figure 2). The diameter of all regions should be the same.

8. Select a small region for FRAP, such as a round region with 20 pixels (less than 2 mm) in diameter

for bleaching. A 488 nm Argon laser could be used to bleach the H1-GFP signal. Adjust the laser

power and bleach time length to improve bleaching efficiency. The bleaching efficiency should

be at least 70%.

Here is the detail for FRAP setup (Methods video S1).
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a. Set the regions for bleaching; Click the round tool to add a round region on the image ac-

quired on step 7. Set both the width and height as 20. The size of regions could be adjusted

for different cells or different propose, but it should be kept the same in the same experiments

or repeats in different groups.

b. Unfold the bleaching tool bar, and set the ‘‘Start Bleaching after # scans’’ as 5 and ‘‘Repeat

bleach after # scans’’ as 12.

Figure 1. Setup for FRAP imaging

(A) Seed cells on a focal dish with glass bottom.

(B) Put the dish on a 10 cm dish to avoid split out.

(C) Put the dish in a carried-on incubator before imaging.

(D) Put the dish on the stage of microscope with an incubator system.

(E) Setup the confocal microscope for imaging and FRAP.
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c. Choose 488 nm laser for bleaching and adjust the bleaching laser power. Click the ‘‘Test

Bleach’’ to find the popper laser power or directly click ‘‘start experiment’’ to acquire a

FRAP movie and evaluate the bleaching efficiency. The bleaching efficiency should be at least

70%. The setting for bleaching should not be changed in the whole experiment after finding a

proper setting.

d. Open the setting bar of ‘‘Time Series’’, set the cycles as 200 and interval as 1.0 s.

e. Open the setting bar of ‘‘definite focus’’ and choose ‘‘defined’’ model to keep focus.

9. Adjust the setting on the microscope and make sure only acquiring a single channel image as H1-

GFP (Click off the tracker for acquiring HP1a-cherry, Movie S1). Record the image series contain-

ing 5 frames before bleaching and 2–3 min time-lapse images after bleaching.

CRITICAL: Before the imaging work, replace the cell with fresh cell culture medium. The

incubation system on the microscope should be settled at least 10 min before the exper-

iments. The fraction of temperature will shift the focus on time-lapse imaging. Trouble-

shooting 3.

Choose the cell with proper H1-GFP signal level. Too weak the signal of H1-GFP may easily get pho-

tobleached. Troubleshooting 1.

Fluorescence intensity measurement

The image J software could be used to quantify the fluorescence intensity with raw images of FRAP

acquired by confocal microscope. The times-lapse FRAP images might have some drift both from

system drift or cell movement, which should be corrected. The fluorescence intensity of bleached

regions could be quantified after drift correction.

10. Drift correction

a. Open the raw images with Fiji image J (Methods video S2).

b. Crop an interesting region containing one cell or only one nucleus.

c. Correct the image shift and rotation with TurboReg and StackReg tool. Select the tool as

following. Image J > Plugins > StackReg.

11. Find the bleached regions.

Figure 2. Region selection for FRAP

The regions marked with HP1a are selected as heterochromatin foci, while the other regions are euchromatin. Scale bar, 5 mm.
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a. Find the bleached regions with the ROI manager tool. Click the selecting tool on the main

panel of image J. Draw a circle with 20 pixels in diameter as follows. Analyze>ROI manager>-

More>specify. Click ‘oval’ and set the diameter as 20 pixels, the same size as photobleaching

setup.

b. Move the selecting circle to the bleached region at the fifth frame. Click ‘update’ on the ROI

manager tool window.

c. Add a circle at the non-nuclear region as background.

12. Measure the fluorescence intensity in the selected regions.

a. Open the Multi-measure tool as following. Plugins>Multi Measure.

b. Select all the circles and add them to the multi-measure box using the tool of add<SP> in this

window of this plugin.

c. Click Multi-Measure on the tool window of the multi-measure plugin. The intensity of the re-

gions will be shown in a new window.

d. Copy the data and paste it into a new work sheet of excel (Table 1).

Optional: Image J with proper plugins for recognizing the raw images generated by the

confocal microscope could also be used.

FRAP curve

13. Fluorescence intensity calculation.

a. The fluorescence intensity of FRAP regions should subtract the background intensity at first

(Methods video S3).

b. Calculate fluorescence intensity before bleaching region with the average fluorescence in-

tensity in the test region with the first 5 frames.

c. Calculate the relative fluorescence intensity. Use the fluorescence intensity of regions after

bleaching relative to the average fluorescence intensity of the same region in the 5 frames

of images before bleaching.

14. Construct FRAP curve.

a. Combine all the relative fluorescence intensity data from heterochromatin regions in one

group, and the data from euchromatin in another group.

b. Open the GraphPad software. Choose the ‘‘XY’’ model in graph construction (New table and

graph>XY>Choose a graph>Connecting line only). Input the correct number of repeat value

in ‘‘Y’’. Choose ‘‘Mean and Error’’ and ‘‘SEM’’ in the dialog. Click ‘‘Create’’ to start.

c. Paste the time point in the ‘‘X’’ and paste all the relative fluorescence intensity data column

by column. the software will calculate the mean value and SEM of the relative fluorescence

intensity of heterochromatin or euchromatin automatically.

d. Construct the FRAP curve using GraphPad Prism by click ‘‘Graphs>Date’’, (Figure 3). Adjust

the setup of connecting line and error bar.

15. Statistical Analysis

a. Two tailed student t-test could be used in statistical analysis with GraphPad Prism (Melcer

et al., 2012).

b. The recovery ratio at 120 s after bleaching could also be used to evaluate the percentage of

the mobile fraction (Figure 3).

Optional: The FRAP curve could also be constructed with Microsoft Excel in a similar way. The

mean value and SEM/SD value could be calculated on Excel. Select the mean value of relative

recovery rate and construct a line graph by using ‘‘Scatter and smooth line’’ model (Excel>In-

set>Charts>Scatter>Scatter and smooth line). The error bar could be added by using the SEM

or SD value.
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Table 1. Fluorescence intensity in FRAP with H1-GFP

Frame Region1 Region2 Background

1 134.497 105.975 1.227

2 128.413 101.714 1.045

3 126.984 101.534 1.239

4 126.763 101.335 1.076

5 124.462 101.172 1.166

6 11.499 11.528 0.928

7 15.64 15.491 1.065

8 19.708 19.867 1.16

9 24.188 22.474 1.045

10 27.675 24.186 1.031

11 31.309 28.358 1.329

12 33.951 29.742 1.249

13 35.706 32.454 1.297

14 37.998 33.045 1.172

15 41.092 35.448 1.135

16 42.501 37.487 1.19

17 45.045 38.47 1.431

18 46.444 39.078 1.225

19 47.589 40.274 1.162

20 50.168 41.08 1.166

21 50.933 42.2 1.2

22 53.129 43.139 1.166

23 53.215 43.959 1.221

24 56.272 44.732 1.106

25 56.491 46.853 1.339

26 57.307 47.618 1.266

27 58.47 47.176 1.286

28 60.147 49.564 1.17

29 61.088 49.143 1.297

30 61.783 49.575 1.301

31 62.975 50.282 1.211

32 63.855 50.012 1.07

33 63.941 51.505 1.225

34 64.204 51.959 1.2

35 67.035 53.575 1.088

36 66.356 52.194 0.996

37 67.153 52.72 1.104

38 68.387 53.319 1.331

39 68.209 53.898 1.174

40 68.869 52.888 1.225

41 69.648 53.691 1.227

42 70.671 53.597 1.133

43 71.157 54.507 1.29

44 71.37 55.143 0.996

45 71.72 55.624 1.117

46 72.348 56.225 1.188

47 74.378 55.761 1.307

48 73.693 56.372 1.249

49 73.697 56.313 1.096

50 75.489 56.417 1.162

51 75.153 57.45 1.19

52 75.137 57.524 1.249

53 74.534 56.683 1.202

(Continued on next page)
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Table 1. Continued

Frame Region1 Region2 Background

54 76.072 56.278 1.342

55 77.804 56.914 1.086

56 78.828 58.863 1.182

57 77.072 57.284 1.074

58 79.407 57.859 1.16

59 78.746 59.006 1.213

60 78.409 58.857 1.149

61 78.988 58.36 1.057

62 80.487 59.513 1.415

63 80.16 58.82 1.211

64 79.984 60.748 1.102

65 81.309 58.971 1.186

66 81.307 59.423 1.143

67 81.579 59.262 1.115

68 81.016 58.18 1.376

69 81.125 59.247 1.211

70 81.648 59.329 1.166

71 83.266 60.037 1.378

72 81.403 59.902 1.315

73 82.806 59.947 1.174

74 82.223 59.896 1.204

75 83.084 59.644 1.133

76 82.755 59.961 1.209

77 84.429 60.515 1.155

78 84.421 60.808 1.198

79 84.495 61.082 1.006

80 83.546 60.56 1.004

81 84.63 60.62 0.99

82 82.575 61.184 1.108

83 84.307 61.998 1.252

84 85.685 61.329 1.215

85 84.323 62.313 1.221

86 86.491 62.08 1.211

87 85.689 63.534 1.303

88 85.961 61.176 1.172

89 85.808 62.211 1.231

90 85.239 62.712 1.231

91 85.092 63.174 1.276

92 85.998 62.27 1.108

93 87.299 61.818 1.215

94 86.644 63.061 1.225

95 87.329 62.988 1.18

96 87.18 62.687 1.401

97 86.83 63.09 1.245

98 86.761 62.742 1.258

99 88.552 63.082 1.247

100 86.963 62.738 1.135

101 89.082 64.329 1.08

102 87.018 63.851 1.02

103 88.466 62.871 1.143

104 87.057 63.865 0.992

105 87.217 64.078 1.035

106 87.822 63.571 1.157

107 87.683 63.431 1.319

(Continued on next page)
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Note: Three Plugins as StackReg, TurboReg and Multi-Measure should be installed.

EXPECTED OUTCOMES

The recovery rate and ratio of H1 with FRAP could be used to evaluate the euchromatin or hetero-

chromatin loosening effect. The higher rate of H1-GFP recovery, the higher dynamics of chromatin

and contains more loosen chromatin. The high percentage of mobile fraction also could be evidence

in high mobility and loosen of chromatin. Here is an example of loosen chromatin by adding VPA in

somatic cell reprogramming (Figure 4).

LIMITATIONS

The HP1a marked heterochromatin foci is not much obvious in some human cells, such as human

fibroblast, SK-Hep-1 and so on (Figure 5). In such case, you can use the HP1a-cherry marker to avoid

choosing heterochromatin foci and only count the euchromatin dynamics.

Cells in senescence or mitosis always have an abnormal chromatin which shows high contrast in H1-

GFP between different regions.

Combining with heterochromatin foci area counting with immunofluorescence, it could tell more de-

tails in chromatin dynamics, including heterochromatin transform into euchromatin.

This method can be used to detect a global change of chromatin. The dynamics in a special gene

locus could also be detected combining with a special marker in live cells.

TROUBLESHOOTING

Problem 1

The H1-GFP signal is too low and the recovery curve may not be reliable (step 2).

Potential solution

High dose of virus coding H1-GFP should be used to infect the cells. Choose the cells with brighter

fluorescence could also solve the problem. Use a highly sensitive PMT in confocal imaging could also

benefit for collecting weak signal, such as GaAsP PMT and so on.

Problem 2

The bleaching efficiency is too low (steps 7–9).

Table 1. Continued

Frame Region1 Region2 Background

108 88.305 63.335 1.231

109 88.215 62.935 1.057

110 88.838 62.515 1.202

111 89.603 63.802 1.178

112 89.266 63.393 1.157

113 89.446 63.975 1.409

114 88.454 62.632 1.153

115 90.624 63.55 1.274

116 88.573 64.051 1.125

117 89.393 64.507 1.389

118 89.405 64.72 1.274

119 90.761 63.227 1.213

120 88.45 63.286 1.266

121 88.524 64.26 1.397

122 87.796 62.554 1.115

123 88.526 63.37 1.247
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Potential solution

A high power and continues laser, such as argon laser, is better for FRAP experiment. Pulse laser may

not suitable for bleaching GFP signal. Increasing the bleaching time could also increase the bleach-

ing efficiency, but too much bleaching cycle will delay the recovery process and add more variation.

Problem 3

Focus and XY drift in time series imaging recoding in FRAP (steps 9 and 10).

Potential solution

The focus in Z-axis may be lost as temperature change or cell movement. The confocal with cells

should be prewarmed for a few minutes before FRAP experiment to minimize temperature caused

focus drift.

The XY drift could also be generated by cell/nucleus movement or the confocal system drift, which

could be corrected by StackReg and TurboReg plugin of Image J discribed in step 10. The StackReg

plugin should work together with TurboReg plugin, which could align image stack through

comparing the landmarks of two neighboring images in one stack (Thevenaz et al., 1998). A focus

stabilization system could also be used, such as definite focus system on Zeiss microscope or perfect

focus system on Nikon microscope.

Problem 4

The photobleaching in time series imaging (steps 7–9).

Potential solution

The higher power the laser used, the more photobleaching in acquiring time series imaging. To

avoid photobleaching in image acquiring, the power of laser should be as low as possible. The highly

sensitive PMT would benefit the process as lower power of laser is needed for imaging.What’s more,

the photobleaching could be corrected by choosing a similar region in a none bleaching nucleus as

reference, although it is not always available as the small imaging scale.

Problem 5

The recording time for each frame is too long (steps 8 and 9).

Figure 3. FRAP curve of H1-GFP in MEF cells

The mobile fraction (MF) and immobile fraction (IF) of heterochromatin and euchromatin is marked. The data were

represented as mean G SEM (n=12 for heterochromatin regions, and n=15 for euchromatin regions).

ll
OPEN ACCESS

STAR Protocols 2, 100706, September 17, 2021 11

Protocol



Potential solution

It should take no more than 1 s in recoding each frame image in FRAP as the recovery rate is high for

H1-GFP. Too long the recoding time will lower the resolution in FRAP analysis. The resolution of each

frame could be set as 5123512 to balance the contradiction between resolution and recoding rate.

Choosing the round trip scan model could also reduce the recoding time, but we didn’t recommend

as the drift in each scan in some cases.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Xingguo Liu (liu_xingguo@gibh.ac.cn).

Materials availability

All materials are available commercially. The plasmids of pMX-H1-GFP and pMX-HP1a-Cherry can

be obtained through contacting the lead contact.

Data and code availability

All plugins for image J used in this study are list in the key resources table and available on NIH

(https://imagej.nih.gov/ij/plugins/). Software is listed in the key resources table.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2021.100706.

Figure 4. VPA opens chromatin

FRAP on H1-GFP were carried out with or without 200 mM VPA treatment for 48 h. HP1a-cherry is added as a maker to

select either heterochromatin or euchromatin.

(A and B) The FRAP curve of euchromatin (A) or heterochromatin (B) with or without VPA.

(C and D) The ratio of MF in euchromatin (C) or heterochromatin (D).

The data were represented as mean G SEM in A and B, while mean G SD in C and D (nR12 regions for each group),

Two-tailed unpaired student t-test were used. N. S represents p>0.05. *p % 0.05, **p % 0.01, ***p % 0.001.
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Figure 5. Chromatin foci in human fibroblast cells

Human fibroblast is labeled with H1-GFP and HP1a-cherry. HP1a-cherry is used to indicate heterochromatin foci. Scale bar, 5 mm
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